03-QUICKSTART — CODE
COMPOSER™ STUDIO

Stellaris® Development and Evaluation Kits for
Code Composer™ Studio

The Stellaris Development and Evaluation Kits provide a low-cost way to start designing with
Stellaris microcontrollers using Texas Instruments’ Code Composer Studio development
tools. The evaluation boards can function as either a complete evaluation target or as a
debugger interface to any external Stellaris device.

Requirements

= You have a PC with a USB interface, running Microsoft® Windows XP (SP2 or greater)
or Vista
= You have the Workshop Installation Software Flash Drive

CAUTION: There is a known electrical issue with the FT2232 device that is used in the
on-board In Circuit Debug Interface (ICDI). Some USB hubs can cause the device to
misbehave, with symptoms ranging from failed enumeration to corrupt data transfers. If you
experience trouble when using the on-board ICDI, try connecting the USB cable directly to
one of the USB ports on your PC or laptop.

Code Composer Studio

This quickstart shows you how to install the Code Composer Studio development tool and
how to use it to build and run an example application on your Stellaris Evaluation or
Development Board.

Step 1: Install Code Composer Studio

1. Disconnect any evaluation board that you have connected to your PCs USB port(s).
Insert the Workshop Installation Flash Drive into a free USB port.

2. Using Windows Explorer, find the setup_CCS_4.1 folder on the Flash drive and
double-click on the file named setup_CCS_n.n.n.n.exe.

3. Follow the instructions in the Code Composer Studio installation program. Select the
Platinum Edition for installation when the Product Configuration dialog window
appears. Click Next.
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4.

5.

Code Composer Studio v4 Setup
Product Configuration

Select the Product Configuration that best suits your needs.

Select the Product Configuration that you wish to install. Mare detailed installation options will be
presented on the next screen,

| Platinum Edition Description
Microcontroller Edition This is & complete installation
Scripting Tools induding all features and
Custom support for all device families.

By default a 30 day
evaluation license will be
generated.

[ < Back ]l Mext= | l Cancel l

In the Choose ISA dialog, if you are attending a Stellaris only workshop, make sure
that only the Stellaris Cortex-M3 MCU and ARM checkboxes are selected. If you

are also attending an MSP430 workshop, check that checkbox too. Click Next.

Code Composer Studio v4 Setup

Choose ISA

Select ISA support to be installed

MSP430 16-bit Ulira-Low Power MCUs

[Jc28x 32-bit Real-time MCUs

[¥]stellaris CortexI3 MCUs

[ JHercules Cortex-R4F MCUs

[ Digital Media & Application Processars (OMAP, DaVind and Sitara)
[ ]c54x DsPs

[Jessx Dsps

[Jceooo DsPs

ARM

[ < Back ][ Mext > ] [ Cancel ]

In the Select Components dialog, uncheck the Target Content and Emulators
checkboxes. If you are attending a Stellaris only workshop, click Next. If you are

attending a MSP430 workshop too, check the MSP430 USB FET checkbox and click

Next. The installation should take less than 10 minutes to complete.
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Code Composer Studio ¥4 Setup X

Select Components { P Y
Select the components wou want to install and deselect the components H ""
wou do nok want to install, T e

- o
—Description
Code Generation Tools .ﬂ B

- Swstem drivers for the
& [ Target Content M5P430 LIS Flash Emulation

O osryeros 6.x Toul.

O e and o

O =pc Tools

O «oals
= O Emulators

MSP430 LISE FET s

-

1.01 B of space required toinstall selected configuration.
£7.43 GB is available on the current drive.

Texas Instruments

< Back | Mext = | Cancel |

If you’ve been tasked with installing Code Composer only, please stop here and ask your

instructor for further directions.
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Step 2: Install the StellarisWare® Package

A full set of C-based peripheral drivers is provided, covering all peripherals and functionality

of the Stellaris devices. The StellarisWare package includes various example applications
with project files for all major tool vendors that support Stellaris, including Code Composer
Studio. To install StellarisWWare components, follow these steps:

1. Make sure that the Workshop Installation Flash Drive is inserted into one of your
PC’s USB ports.

2. Using Windows Explorer, open the Flash drive and find the StellariswWare
installation file that matches your board.

e LM3S3748 board SW-EK-LM3S3748-5451.exe
e LM3S8962 board SW-EK-LM3S8962-5451.exe

Double-click on the file for your board and select the default installation location
when prompted. If you intend to run the labs for both boards, you will need the
drivers and StellarisWare for both boards installed.

If you run a second (or more) StellarisWare installation, use the default installation
directory. The board files will be installed in separate folders for each board. When
you are warned about overwriting files, click Yes to all. All the overwritten files are
the same.

NOTE: Check the www.ti.com/Stellaris web site for the latest software updates.
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Step 3: Start Code Composer Studio and Open a Workspace

1. Start the Code Composer Studio IDE by selecting it from the Windows Start menu
or double-clicking the icon installed on your desktop.

When the IDE loads, it asks you where to open the workspace folder. To keep your
projects separated, you should use a workspace for each board.

If you are using the LM3S3748 board, name your workspace workspace_3748.
If you are using the LM3S8962 board, name your workspace workspace _8962.

Do not check the Use this as the default and do not ask again checkbox. While it’s

possible to switch back and forth in the IDE, it’s best to select your workspace at the start
to prevent confusion. Click OK.

) Workspace Launcher

Select a workspace

Code Composer Studio stores your projects in a folder called a workspace.,
Choose a workspace folder to use for this session.

Workspace: | ments and

Settings'\Don cspace 3748 v|[ Browse...

[ ] Use this as the default and do not ask again

Ok l [ Cancel
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2.

If this is the first time you have run Code Composer Studio IDE, a dialog box may
appear like the one shown below. If the dialog appears, select Evaluate Code
Composer Studio for 30 days unless you already have a license that you wish to
activate. Click OK to continue.

NOTE: If you have previously installed a Code Composer evaluation disk, you may
not be able to move beyond this screen. Ask your instructor for assistance.

@ Welcome to Code Composer Studio rz|

Ma walid license for Code Compaser Studio could be found.

(%) Evaluate Code Composer Studio for 30 days!
(") Activate a License

Step 1 - Generate License File

Step 2 - Install License File
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3. Code Composer Studio may now open with the welcome page. If so, close out the
welcome page by clicking the link in the upper right

Start using CCS

or by clicking the X on the tab. You should now have an empty workspace like that
shown below. Maximize the window.

8 C/C++ - Code Composer Studio (Licensed : 30 Days Remaining)

Elle Edit View Mavigate Project Target Toals Window Help
& E i < X P | Rcic++ |
F & ¥ An outline is not available.,
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Step 4: Import Libraries

1. From the menu bar, click on Project, and then select Import Existing CCS/CCE
Eclipse Project.

¥ C/C++ - Code Composer Studio {Licensed)

File Edit View MNavigate QEi2=d Target Tools Scripts  Window Help

! ga B |z Build Active Project Cirl+5hift+P
£ Rebuild Active Project Alt+shift+F -

¥l C/C++ Projects X

&,/ Import Existing CCS/CCE Edipse Project
Elmport Legacy CC5v3.3 Project
Build A Cirl+5

qjRebuild Al Alt+B

m m

Build Warking Set ¥

Build Automatically

Link Files to Active Project...
Add Files to Active Project...
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2. The Import dialog appears. Browse to the root directory of the driver library
(C:\Stellarisware\driverlib) and click OK. Be sure that the checkbox next to
driverlib in the Project pane is checked and that Copy projects into workspace is
unchecked. Click Finish.

Import Projects

Select a directory to search for existing Eclipse projects, / .
-

(®) Select root directory: | C:\StellarisWare \driverlib | | Browse... |

(O select archive file: | |

Projects:

driverlib Select All

Deselect All

il

Refresh

|:| Copy projects into workspace

(7 Finish ] [ Cancel
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3. SKip this step if you are using the LM3S8962 board.

Select Import Existing CCS/CCE Eclipse Project from the Project menu again.
Browse to the root directory of the USB library (C:\Stellarisware\usblib) and click
OK. Be sure that the checkbox next to usblib in the Project pane is checked and that
Copy projects into workspace is unchecked. Click Finish.

Import Projects —
Select & directory to search for existing Eclipse projects. @
-
(&) select root directory: | C:\stellarisWare \usblib || Browse... |
) select archive file: | |
Projects:
usblib Select Al

Deselect all

Refresh

D Copy projects into workspace

Pl
]
)

Einish ] [ Cancel
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4. Skip this step if you are using the LM3S8962 board.

Select Import Existing CCS/CCE Eclipse Project from the Project menu again.
Browse to the root directory of the graphics library (C:\StellarisWare\grlib) and click
OK. Be sure that the checkbox next to grlib in the Project pane is checked and that
Copy projects into workspace is unchecked. Click Finish.

¥ Import f'5_<|

Import Projects
Select a directory to search for existing Eclipse projects, @

(%) Select root directory: | Ci\stellariswaregrlib | [ Browse, .. ]

(O select arehive fle: | |

Projects:

arlib Select Al

Deselect all

i

Refresh

|:| Copy projects into workspace

@ uinish | [ Cancel
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Step 4: Import Board Example

5. Select Import Existing CCS/CCE Eclipse Project from the Project menu again.
Browse to the root directory for your chosen board ...

e C:\StellariswWare\boards\ek-Im3s3748 for the 3748 board
e C:\Stellarisware\boards\ek-Im3s8962 for the 8962 board
Browse to the root directory of the hello project and click OK.

The example screen shot below has the EK-LM3S3748 board as the chosen board.
(C:\Stellarisware\boards\ek-Im3s3748). Be sure that the checkbox next to hello in the

Project pane is checked and that Copy projects into workspace is unchecked. Click
Finish.

Import Projects y
Select a directory to search for existing Eclipse projects. :-: ;

-

@ select root drrectory: | C:\StellarisWare \boards\ek4m3s3743\n | [ Browse... |

) select archive file: | |
Projects:
hello [ selecta

|
|
|

|:| Copy projects into workspace

@ Finish ] [ Cancel
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6. All of the imported projects now appear in the Projects Explorer pane.

59 C/C++ - Code Composer Studio (Licensed)

File Edit View Navigate Project Target Tools - Window Help
RE® - D A IRl o | Bcic++ |
Z|BES~ An outine is not available.
S driverl
&S b
&% hello [Active - Debug]
15 ushlib

Since the hello project was the last one imported, it becomes the Active Project.
Otherwise, you can right-click on it a set it as the Active Project.
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Step 5: Building and Debugging a Project

1. Make sure that the power switch on your development board is in the SELF position,
if your board has a switch. Then connect your development boards DEBUG USB port
to your laptops USB port. Don’t change the position of this switch while the board is
powered as you may damage the switch’s internal contacts.

2. On the menu bar, click on Project and select Rebuild Active Project. The build may
take a few moments. As the project builds, messages scroll by in the console window.

When the build is complete, the words Build complete for project hello will appear
in the console window.

& C/C++ - Code Composer Studio (Licensed)

B
File Edit WView Navigate Q@& Target Tools ks Window Help
: & %—3 B logh Build Active Project Ctrl+5hift+ Ej' | E cic++ |
= B Rebuid Active Project Alt+5hift+P —
3 C/C++ Projects X — = B || 3= outiine 2 = (=)
(% Import Existing CC5/CCE Edlipse Project An outline is not available.
X Impaort Legacy CCSv3.3 Project
B driverlp Dime o 2
T
e grib [ Bt Al Cirl+8
1 hello [Active -Ds 230 chid al Alt+8
B 1= usblib =

Build Project

Build Working Set 3
Clean...

Build Automatically

Link Files to Active Project...
Add Files to Active Project...

2
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3. On the menu bar, click on Target and select Debug Active Project. Alternatively,
you can simply click the Debug Launch icon % on the menu bar.

1% C/C++ - Code Composer Studio (Licensed) B
File Edit View MNavigate Project WEIGS# Tools Scripts Window Help
: = g_«é 0 : :;3 ~ New Target Configuration... L ﬁlm‘
w— ®2 Debug Active Project =5 EE — =5
‘ﬁ_ Launch TI Debugger | - |
* & An outline is not available.
T Debug History 4
= driverlib
5 grib Debug...
[ & hello [Active - Debug]
-5 ushib
Bl console 52| (B B | 4 [ 5+ = B ||[El problems 2 » Y =0
|C-Build [hella] |0 errars, 0 warnings, 0 infos
|tms470/bin/0fd4T0 . exe” # ||| Description = Re
"C:/Program Files/Texas B
|Instruments/cosv4/tools/compiler
tms470/bin/hex470.exe"™
"C:/Program Files/Texas
Instrunents/ccsv4/utils/tiobi2b
in/mkhex4bin.exe"
[
Build complete for project hello..
)| = k.|
Do

Code Composer Studio should switch to the Debug Perspective. If it does not, click the
Debug Perspective button * =2 in the upper right.
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4. The Code Composer Studio debugger automatically connects to your evaluation
board, programs the Flash memory, and runs to the beginning of the main() function.
From here, you can examine and modify memory, program variables and processor
registers, set breakpoints, step, and perform other typical debugging activities.

To run the program, select Run from the Target pull-down menu or click the

Run [ button on the menu bar.

"] Debug - hello.c - Code Composer Studio (Licensed)
Fle Edit View MNavigate Project REgeSdl Tools Soipts Window Help
g &8 |_‘_Ijl_‘ i, @ @ LoadProgram... Cirl+alt+ o B | % Debug | B clc++
- (£ Relnad Program Cirl+alt+R =
- x i # 7 7 B || 0=Local (1) & | Watch f @ Y08
Bcbud % o Load Symbols... & el (s B|$ &80
= % Dello [Debug] - Stellaris In-Cirf 4% Add Symbols... Sessian] Name Value Address Type
Bk Deviee
B Thread [mair] (Suspef v G Conmect Target Alt+C
=40 mzin() at hello.d Disconnect Target Alt+D
= 1_args_main{) at
v Stellaris In-Circuit Debug 1 &Raslart
o Stellaris In-Circuit Debug 1
@, Go to Main
I=Run F8
[ Terminate All Cirl+Alt+T
_Step Into FS
L Step Over 6 P 5
_Assembly Step Into =g
= Assembly Step Over
_[fStep Return [ il Lo/
“hReset »
Set the clg Advanced » Fystal.
ROM_SysCtlClog (% NewTarget Configuration... E_OSC | SYSCTL_OSC_MAIN
35 Debug Active Project
ﬁLaunch TIDebugger
f/ Initialize Debug Histary e
Debug... e
B console 52 Eepf #B-F5-708
hello [Project Debug Session] Stellaris In-Circuit Debug Interface_0/CORTEX_M3_0 {10:01:43 AM)
¢ Warning loading file 'C:\Program Files\Texas InstrumentsiccsvéiemulationigeliCortexM3 util.gel', line &8: the fum(A
Map Initialization Complete
utput: Watchdog Timer Enabled
v
< >
0 B E LE

Note the display on your board. If everything has worked properly, you should see Hello
World on the display. Don’t worry about the preprogrammed application that came with the
board, we’ll re-flash it in the Flash Programmer section later.

Click the % Jifi C/C++ Perspective button in the upper right of your display to return
to the editor perspective.

Right-click on hello in the Project pane and select Close Project from the list.

If you are not going to run the next lab section, Close Code Composer Studio now.
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Optional!

The following section should only be attempted if you have sufficient time to
complete it. Let your instructor know that you’'re ready to start this section.
Otherwise, you can complete it at home.

Creating a New Project

Once you have gone through the StellarisWare example applications, you may want to create
your own project to begin development. While you can always start with an existing, simple
project, sometimes you may want to start fresh.

The example provided below creates a fresh project, copies code from an existing project, and
builds the new project.

1. To add a new project to your workspace, go to File > New - CCS Project.

B C/C++ - blinky.c - Code Composer Studio (Licensed)

3-8 Edit “iew Mavigate Project Target Tools Window Help
Mew File... @ Standard Make Project 1
Open File... @ RTSC Configuration Project
Close Crl+w @ Folder
Close all Ctrl+5hift+w |£|<} Source File
E Header File
[ File
(& Class
[&] Target Configuration File
333 DSP/BIOS v5.xx Configuration File
EED::;;I ) = &Y RT5C Configuration File |
Refresh F5 f“j‘ Other...
Convert Line Delimiters To Ll = . i J—
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2. Code Composer Studio prompts you with a dialog asking you to name the project
(how about my_project) and specify the location of the project. Name your project,
specify the location (your default workspace will do), and click Next.

% New CCS Project X
CCS Project
Create a new CCS5 Project. @

Project name: |my4:uru:ujeu:t |

Use default location

Location: | C:/Documents and Settings /knorman My Documents fi |
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3. The next dialog asks for the project type and configurations. Select ARM as the
project type, check both the Debug and Release configurations, and click Next.

% New CCS Project (%]
Select a type of project
Select the platform and configurations you wish to deploy on @
Project Type: |.-5.Rr~"l b |
Configurations:

&% Debug
B Release -SEIEI:t Al
Desslect Al

[ ]5how all Project Types
[]show all Configurations

Finish Cancel

7 . < Back ” Mext =
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4. The next dialog allows you to define any inter-project dependencies. If your project
will be using driverlib, usblib, or grlib, now is a good time to define that
dependency. Select those libraries and click Next.

% New CCS Project X
Additional Project Settings
Define the inter-project dependencies, if any. @

& Projects | C/C++ Indexer

Referenced Frojects

[ Ezes expanded_key
[ = zes_set key

[ =5 bitband

1 =5 blinky

122 driverlib

[l Ig'l:-enet_l'fvip

] e enet _ptpd

] '[éc-enet_uip
M1 128 anin itan

|2

(£

Finish Cancel

'\':’,' < Back ” [ext =
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5. On the next dialog, select the appropriate Stellaris device, little endian, the T1 code
generation tool, ELF output format, and the rtsv7M3_T le_eabi.lib runtime
library. Click Finish.

% New CCS Project X]
CCS Project Settings )
Select the CC5 project settings, @

Cutput type: |Executable w |

Project settings

Device Variant: |Cu:urtex Ll V| | V| [ Mare... ]

Device Endianness: |Iitt|e w |
Code Generation tools: |T[ w46, 1 W | [ Mare... ]
Qutput Format: |Eal:|i (ELF) W |
Linker Command File: | Im3s3b90. cd - | [ Browse... ]
Runtime Suppart Library: | rtsv M3 _T_le_eabi.lib V| [ Browse,.. ]

[Jtreat as an Assembly-only project

Target content

@ Mone
(") Use DSP/BIOS v5.xx

") Enable RTSC support {required for DSP/BIOS v6.xx, Codec Engine v3.xx, etc.)

':':7:' I Einish ] [ Cancel l

6. A new project has now been created, but the project does not include any source code.
The next step is to add some startup code to the project. Using Windows Explorer,
copy the startup_ccs.c file from an existing example directory in StellarisWare (such
as C:\StellarisWare\boards\<board>\blinky) to your new project directory created
in step 2 above (in your My Documents folder).
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7. Create a new C source file by going to File > New -> Source File.

% C/C++ - Code Composer Studio (Licensed)
F =l Edit View

Mavigate Project Target Tools

Scripks

Window Help

New S Sg [T CCS Project
Mew File... Standard Make Project -
Open File... RTSC Configuration Project -
Close Cirl+ [ Folder
E] — . Iﬁ Header File
S [ File
E’@ A eanres @ Cass
— [#] Target Configuration File
333 DSP/BIOS v5.xx Configuration File
:z:;';nla. ) - &8 RT5C Configuration File
Refresh F5 ¥ Other...
Crmuart | ime Nielimitars T [

8. Inthe dialog box that pops up, name the file main.c and click Finish.

% New Source File

Create a new source file, C )
Source Folder: | my_project | [ Browse. .. ]
Source File: | main.d| |
@ Einish ] [ Cancel
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9. Code Composer Studio will open the main.c file for editing. Add a main() function

to main.c as shown below. Save the file by clicking the k= Save button.

B SRR R CRCE

while (1)

10. Both files, main.c and startup_ccs.c, should have automatically been added to the
project. If not, right-click on my_project in the Project pane, select Add Files to
Project and browse to the files.

= I:.- mv project [Active - Debug]
Fg Indudes

L] main.c

E] startup_ccs.c

L] Im3s3748.cmd

[+

[+

11. Build the new project by selecting Project - Rebuild Active Project.

With your project created, all you really need to do is add your own code. Use the existing
StellarisWare board examples as a reference.
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NOTE: To set up your project to output a binary file (.bin) to be used with tools such as LM
Flash Programmer, copy the post-build step from an existing StellarisWWare example project.

L] Properties for mpu_fault

|lpe filter text | C/C++ Build
H Info | active configuration
i Builders ) =
.. CjC++Buid Project Type: |/
: GfE+ Documentation Configuration: |Debug B | [Manage‘.. ]
o CfC++File Types
CfC++ Indexer Configuration Settings
i CCS Build -
i CCS Debug | Tool Settings | Build Settings | Euild Steps i Error Parsers | Binary Parser || Environment || Macros |
: Project R.efen.ances Pre-biild step:
Refactoring History
Command:
Description:
Post-build step:
Command:
| "S{CCE_INSTALL_ROOT}/utils tiohj 2hin/tiohj 2bin.bat™ "s{BuildartifactFileName} ™ “s{BuildartifactFileBaseMName}.bin™ "S{CG_TOOL_ROOT}/bin/ofd470.exe”™ "s{CG |
Description:
Apply Predefined Step: “ |
[Resbore Qefauhs] [ Apply ]
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Conclusion

You have now installed the Code Composer Studio development tools and used them to build
and load an example application on your Stellaris Evaluation Board. From here, you can
experiment with the debugger or start creating your own application using the example
projects as a reference. For further information on Code Composer Studio, go to the CCS

Developer Site.
Window IIEH

P I Welcome
' CCSv4 Developer Site !
— I:EI Help Contents p—
L int i
3 lmmin &7 Search
: Dryniamic Help

Key Assist,,, Cirl+shift+L

5 Software Updates »
7 Licensing Options...

About Code Composer Studio

Close Code Composer Studio now.

References

The following references are included on the Stellaris Evaluation Kit Documentation and
Software DVD and are also available for download at www.ti.com/Stellaris:

= Stellaris Evaluation Kit User's Manual

= StellarisWare Software, Order Number SW-LM3S

= StellarisWare Peripheral Driver Library User’s Guide, Order Number SW-DRL-UG
In addition, the following website may be useful:

= Code Composer Studio website at http://www.ti.com/ccstudio
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